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GSSAAKK  110011!!  
 

Ceci est un guide détaillé pour vous permettre d’utiliser GSAK1. Tous les 
textes soulignés dans ce guide sont un lien à un site web – cliquez sur le texte 
souligné pour aller directement au site web. – Ce guide est très détaillé (étape 
) et peut paraître un peu long.  NE PANIQUEZ PAS ! Une fois que vous aurez 

parcouru au travers de ce guide, vous allez pouvoir utiliser GSAK par vous-même en un 
rien de temps. 
 
VEUILLEZ NOTER :  Ce guide explique comment vous familiariser avec GSAK. Il a 
été conçu afin d’être lu du début à la fin (pas nécessairement d’un seul coup!), et chaque 
section viens compléter la section précédente.  Si vous sautez sur un sujet sans lire le 
précédent, vous manquerez des points-clés et vous ne vous retrouverez plus 
 
Plusieurs aspects ou fonctions de GSAK ne seront pas traités ici; pour les informations 
sur ces aspects et fonctions, référez-vous à la page d’aide de GSAK (dans GSAK, allez 
dans le menu «Help»2, ensuite cliquez sur «Contents», ou appuyez sur la clé F1 de votre 
ordinateur). 
 
GEOCACHING.COM ABONNEMENT PREMIUM 
 
Pour maximiser les avantages de GSAK, vous devrez télécharger les fichiers GPX (non 
LOC) de Geocaching.com. Les fichiers GPX incluent presque toutes les informations de 
la page de cache en ligne et ils vous permettent d’importer toutes ces informations dans 
GSAK. Les fichiers LOC incluent seulement le nom de la cache ainsi que les 
coordonnées (latitude et longitude). Quoique GSAK fonctionnera avec les fichiers LOC, 
vous n’aurez pas les informations de caches détaillées qui vous permettent de tirer 
avantage des différentes caractéristiques de GSAK. 
 
 Geocaching.com requiert que vous deveniez « Membre Premium » 
pour pouvoir télécharger des fichiers GPX. L’abonnement Premium 
coûte $3 par mois ou $30 par année. Pour devenir Membre Premium 
de Geocaching.com, allez sur 
http://www.geocaching.com/subscribe/ et déroulez la page jusqu’à 
«How much is Membership». Choisissez votre méthode de paiement 
(carte de crédit ou Paypal) et les termes de votre abonnement. 
Complétez la procédure de paiement pour devenir Membre Premium 
                                                 
1 Ce document a été adapté à la version 7.2.0 de GSAK 
2 Tous les noms de menu sont donnés en anglais, étant donnée que GSAK n’existe pas en version française. 

http://www.geocaching.com/subscribe/


de Geocaching.com afin de pouvoir télécharger les fichiers GPX et les requêtes 
personnelles («Pocket Queries »). 
 
TÉLÉCHARGER  LE  PROGRAMME  GSAK 
 
Allez sur http://gsak.net/  et téléchargez la version la plus récente de GSAK. Lorsque 
demandé, sauvegardez le fichier sur votre ordinateur (rappelez-vous de la destination de 
la sauvegarde). 
 
GSAK est gratuit à l’essai et coûte $25 US à l’achat. Le téléchargement gratuit inclus 
toutes les caractéristiques GSAK et est pleinement fonctionnel. Après 21 jours 
d’utilisation de GSAK sans enregistrement (achat), vous aurez droit à une petite fenêtre 
tenace ‘Nag’, lorsque le programme se met en marche, et cette fenêtre deviendra de plus 
en plus insistante avec chaque utilisation. Si vous avez apprécié le programme, SVP 
vous enregistrer sur http://gsak.net/Register.php pour l’achat. Lorsque vous aurez 
enregistré (payé), vous recevrez une clé (numéro de série) dans votre courriel. Inscrivez 
votre clé d’enregistrement (numéro de série), et la petite fenêtre tenace disparaîtra en 
permanence. Les utilisateurs enregistrés auprès de GSAK ont présentement droit à toutes 
les mises à jour et améliorations du programme sans frais additionnels. 
 
INSTALLATION  DE  GSAK 
 
Dans Windows, allez à «Démarrer > Exécuter» et parcourez les répertoires jusqu’à 
l’endroit où vous avez sauvegardé le fichier GSAKxxxx.exe (xxxx étant le numéro de 
version). Cliquez sur le fichier, cliquez sur «Ouvrir», et ensuite «OK». 
 
L’installation de GSAK va débuter. Si une fenêtre Windows «Fichier Ouvert - 
Avertissement de Sécurité» apparaît, cliquez « Exécuter ». 
 
Vous devrez d’abord lire et accepter les conditions d’utilisation de GSAK («License 
Agreement»). Nous vous recommandons de laisser GSAK s’installer sur le répertoire 
par défaut («Destination Location»). Cliquez simplement sur «Next» autant de fois qu’il 
le faut, et «Install». GSAK va s’installer sur votre ordinateur. 
 
DÉMARRER  GSAK  POUR  LA  PREMIÈRE  FOIS 

 
Faites un double-clic sur l’icône GSAK  sur le bureau Windows. Le programme 
GSAK va se mettre en marche. 
 

 

http://gsak.net/
http://gsak.net/Register.php


GSAK va vous demander si vous voulez peupler votre Base de Données avec un fichier 
échantillon («sample.gpx»). Si vous êtes prêts à entrer de véritables données dans 
GSAK, cliquez «No». Si vous voulez jouer avec les données échantillons pour vous 
familiariser avant de télécharger de véritables données, cliquez «Yes». 
 
Si vous avez choisis d’utiliser le fichier échantillon de cache, GSAK va vous demander 
d’entrer votre nom de géocacheur, ou votre numéro d’identification GC.com. Si vous 
avez choisis de ne pas l’utiliser, GSAK vous amène directement à l’item suivant (Aide 
pour partir). 
 
Le fait de donner votre identité permettra à GSAK d’identifier les caches qui vous 
appartiennent, ainsi que de dénombrer vos caches trouvées. À moins que vous ne 
connaissiez par cœur votre numéro d’identification GC, je vous recommande pour le 
moment d’entrez votre nom de géocacheur. Vous aurez tout le loisir de modifier ce 
paramètres lorsque vous aurez trouvé celui-ci. Attention, il est important d’épeler votre 
nom de géocacheur correctement pour que GSAK reconnaisse vos caches. 
 
Le fichier d’aide de GSAK «Getting Started» va s’ouvrir. Lisez les 
sujets d’aide et cliquez sur les liens pour vous familiariser  avec le 
programme et ses fichiers d’aide. N’essayez pas de tout mémoriser à ce 
point-ci, ce guide va vous aider étape par étape. 
 
 
UTILISER GSAK 

 
TÉLÉCHARGEMENT DE DONNÉES DE CACHES DANS GSAK 
 
La première chose à faire est de télécharger des données de caches 
dans GSAK. Vous pouvez télécharger des fichiers de caches 
individuels, ou si vous êtes Membre Premium, vous pouvez créer 

des requêtes personnelles (Pocket Queries) sur Geocaching.com, de manière à recevoir 
jusqu’à 500 caches par requête sur votre messagerie e-mail. 
 
A partir de maintenant, nous allons présumer que vous êtes Membre Premium de 
Geocaching.com puisque tel que mentionné plus haut, c’est la meilleure méthode pour 
obtenir les données de caches pour utiliser GSAK. 
 
Dans Windows, créez un répertoire dans ‘Mes Documents’ pour conserver vos 
téléchargements. Nommez-le ‘Géocaches’. 
 



TÉLÉCHARGEMENT  DE  DONNÉES  DE  CACHE  INDIVIDUELLE 
 
Pour télécharger les données d’une cache individuelle, allez sur Geocaching.com et à 
partir de la page de la cache, en haut de la page, sous «Download », cliquez sur «GPX 
eXchange File». 
 

 
 
Une fenêtre «Téléchargement de Fichier» s’ouvrira. Cliquez sur «Enregistrer» et 
sauvegardez ce fichier dans votre répertoire ‘Géocaches’ que vous avez créé 
précédemment. 
 
 
 
TÉLÉCHARGER  LES  DONNÉES  DE  CACHE  DANS  GSAK 
 
Dans GSAK, cliquez sur le menu «File» et cliquez sur «Load GPX/LOC/ZIP». Une 
fenêtre va apparaître pour vous demander de régler vos choix pour assortir les caches 
placées (par vous) et les autres caches (si vous avez utilisé le fichier échantillon lors de 
l’installation, cette étape ne vous sera pas demandée). Ceci est une étape importante afin 
que GSAK reconnaisse qui vous êtes et puisse différencier entre les caches que vous 
possédez et celles que vous trouvez. Entrez votre nom de géocacheur (‘Nickname’) dans 
l’espace prévu (assurez-vous que l’orthographe soit épelé correctement) et cliquez 
«OK». Vous n’aurez à faire ceci qu’une seule fois – la fenêtre d’avis ne reviendra plus. 
 
La boîte de dialogue «Load GPX/LOC/ZIP File» va apparaître maintenant. Cliquez sur 
le petit icône "fichier" à droite de la première boîte d’entrée vide et recherchez votre 
répertoire ‘Geocaches’. Cliquez sur le fichier que vous venez de télécharger, cliquez 
«Ouvrir», ensuite cliquez «OK». GSAK va télécharger les données de la cache dans la 
base de donnée en cours et une fenêtre «Load Summary» va apparaître pour vous donner 
l’information à propos du fichier que vous venez juste de télécharger. Cliquez «OK». 
 
Vous remarquerez que la cache apparaît maintenant comme une rangée dans la fenêtre 
de GSAK, ou dans la moitié du haut de la fenêtre GSAK si votre fenêtre est subdivisée. 



Ceci s’appelle «Grid View» et chaque rangée dans cette grille contient l’information à 
propos d’une cache. 
 
Au bas de la page de la grille, il y a une ligne de renseignements qui vous dira : 
« Subset=None»  «1 Shown (all waypoints)» «Center Point = Greenwich Meridian» 
«Counts : » (suivi de quatre colonnes de couleurs différentes). Placez le curseur sur la 
ligne de base de cette barre de statut et tenez le bouton de la souris pour glisser la barre 
de statut vers le haut. Si vous ne pouvez glisser la barre de statut vers le haut, pesez sur 
la clé F2 de votre clavier (ceci va ouvrir le «Split Screen View»), ensuite, glissez la 
barre de statut vers le haut afin qu’elle soit au centre de l’écran. 
 
Vous verrez maintenant les informations détaillées sur la cache dans la partie inférieure 
de la fenêtre GSAK. C’est ce qui s’appelle un «Split Screen View», une fenêtre 
subdivisée. 
 
Le format par défaut est le «Full Display», affichage complet. Celui-ci vous montre 
toutes les informations sur la cache, incluses dans les fichiers GPX sans besoin d’aller 
sur Geocaching.com. Au milieu de la barre d’outils, près du sommet de la fenêtre 
GSAK, vous trouverez un bouton qui indique «Split Screen Format». Essayez différents 
options sous ce bouton pour visualiser ce qu’il font (Note : vous devrez être branché à 
internet pour que l’option «Online page» fonctionne (visualisation des données de cache 
directement de geocaching.com). Réglez le « Split Screen Format » à «Full Display» 
pour l’instant (affiche les données de la cache à partir de la base de données de GSAK). 
 
 

LOCALISER LA  MAISON   
 
Une des fonctions importantes de GSAK est son habilité à trier ou à 
visionner des caches à partir d’une position donnée. A moins de 
demeurer sur le Méridien Greenwich en Angleterre, (très peu d’entres 

nous y demeurent), vous devrez entrer les coordonnées de «Home Location» 
(coordonnées de votre demeure), qui indiquent où vous demeurez. 
 
Premièrement, vous devez connaître les coordonnées (latitude et longitude) de votre 
maison. Si vous ne les connaissez pas, allez à l'extérieur de la maison avec votre GPS en 
main et marquez un waypoint. Ensuite, trouvez le waypoint sur votre GPS et copiez les 
coordonnées dans GSAK de la façon indiquée ci-dessous. 
 
Allez sur «Tools > Options» et cliquez sur l’onglet «Locations». Placez le curseur sous  
«#Somewhere else » dans la boîte de texte et tapez «Maison», une virgule, ensuite les 



coordonnées de la maison prise par le GPS, séparées par une virgule. Notez bien que les 
coordonnées doivent être du même format que les exemples donnés dans la boîte de 
texte. Soyez sûr que vous mettez une virgule entre le mot Maison, la latitude et la 
longitude. Assurez-vous de mettre la latitude avant la longitude! Assurez-vous de taper 
les coordonnées exactement comme elles apparaissent dans votre GPS, incluant N ou S 
latitude (Nord ou Sud de l’équateur) et E ou W longitude (Est ou Ouest du Méridien 
Greenwich). 
Exemple : 
Maison, N45 34.098, W73 21.876 
 
Cliquez «OK» pour retourner à l’écran grille. Dans le sélecteur «Locations» de la barre 
d’outils GSAK, sélectionnez «Maison». Les caches dans votre grille vont maintenant 
apparaître en commençant par la cache la plus près de votre demeure, en s'éloignant,  
indiquant les distances en kilomètres à partir de votre résidence dans la colonne intitulée 
«Kms». Je vous entend dire : ‘Mais je ne me sert pas des Kilomètres!’. Allez sur « Tools 
> Options » et sur l’onglet «General» dans le côté droit en haut, cliquez sur «Miles» 
sous «Distance Calculation». Cliquez «OK». Le nom de la colonne de distance de votre 
maison est maintenant en  ‘Miles’.  
 

 
ALLER  CHERCHER  DES  ‘POCKET  QUERIES’   
 
Pour profiter de tous les avantages de GSAK, vous aller sûrement 
vouloir télécharger beaucoup de caches dans la base de données de 
GSAK. (Exemple : toutes les caches de votre région). La meilleure 

façon de faire ceci est de générer des requêtes personnelles (‘Pocket Queries’) sur 
Geocaching.com. Pour des informations détaillées sur les requêtes personnelles et un 
guide étape par étape pour les monter, allez sur : http://www.markwell.us/pq.htm ou 
allez directement sur : http://www.geocaching.com/pocket/  et cliquez sur «Create a 
Pocket Query»  (vous devez être en ligne et inscrit comme Membre Premium pour que 
ceci fonctionne). 
 
D’une manière ou l’autre, une fois que vous avez soumis votre requête 
personnelle sur Geocaching.com, un fichier vous sera envoyé par message 
e-mail, habituellement dans les minutes qui suivent. Alors, vérifiez vos 
messages e-mail!!! 
 

http://www.markwell.us/pq.htm
http://www.geocaching.com/pocket/


TÉLÉCHARGER   UN  POCKET  QUERY  DANS  GSAK 
 
Le procédé pour télécharger une requête personnelle «Pocket Query» dans GSAK est 
très similaire à télécharger un seul fichier GPX. Premièrement, sauvegardez le fichier 
ZIP ou GPX attaché à votre courriel dans le répertoire ‘Geocaches’ que vous avez créé 
sur votre ordinateur. Ensuite, allez à «File > Load» dans GSAK et parcourez le 
répertoire ‘Geocaches’. 
 
Cliquez sur le fichier sauvegardé (Note : GSAK est assez intelligent pour télécharger des 
fichiers compressés ZIP ). Cliquez «Ouvrir». Cliquez «OK». Les caches de votre requête 
personnelle «Pocket Query» (jusqu’à 500) seront maintenant téléchargées dans GSAK, 
et un sommaire du chargement apparaîtra. Cliquez «OK» pour fermer le sommaire. 
 
 
VISIONNER  LES  INFORMATIONS  DES  CACHES   
 
Chaque ligne dans GSAK montre maintenant une cache. Si vous cliquez sur la ligne, les 
détails de la cache apparaîtront dans l'écran du bas (si votre écran est subdivisée). 
 
Si vous voulez visionner une cache sur la carte Google en ligne, assurez-vous d’être 
branché sur Internet, ensuite faites un clic droit sur la ligne de la cache, descendez votre 
curseur jusqu’à «Custom URL» et sélectionnez la carte que vous voulez visionner 
(essayez «Google Satellite View» au bas de la liste des «Custom URL»). 
 

 
TRIER LES CACHES   
 
Cliquez sur le titre des différentes colonnes pour trier l’information 
dans cette colonne. Par exemple, cliquer sur la colonne «Code», va 
trier les caches par le code GC. Cliquez sur cette colonne une 
deuxième fois, va renverser l’ordre de triage. Cliquer sur  la colonne 

«Kms» (ou Miles) va trier les caches par ordre de la distance de votre maison. Cliquer à 
nouveau sur cette colonne va renverser l’ordre de triage. 
 
 
SÉLECTIONNER  DES  CACHES 
 
Pour sélectionner une cache dans GSAK, cliquez sur la colonne sous l’icône  dans la 
ligne d’une cache et un petit crochet apparaîtra dans cette colonne. Ceci est la colonne 
«User Flag» (choix d'utilisateur). Les «User Flags» peuvent être utilisés pour 
sélectionner une cache ou plusieurs caches. Pour sélectionner plusieurs caches, vous 



n’avez qu’à cliquer dans la colonne «User Flag» pour chacune des caches que vous 
voulez sélectionner. Vous pouvez aussi sélectionner plusieurs caches à partir du menu 
«User Flag» ou en utilisant un raccourci sur le clavier. Cliquez  sur le menu «User 
Flags» pour voir les différents choix). 
 
Un moyen utile pour sélectionner un nombre élevé de caches est «User Flags > Set for 
Next nn Records». Que sont les « nn Records »? Ca veut simplement dire « les nn 
prochaines caches » dans la grille GSAK. Pour utiliser cette option, cliquez sur 
n’importe quelle cache sur la grille, ensuite allez à «User Flags > Set for Next nn 
Records» pour sélectionner les (nn) caches suivantes. Tapez 10 dans la boîte qui apparaît 
et cliquez sur «OK». Vous verrez que les 10 caches à partir de celle que vous aviez 
sélectionnée ont maintenant un crochet dans la colonne «User Flag». 
 
Pour enlever un « User Flag », cliquez simplement sur le crochet dans la colonne de 
cette cache à nouveau et le crochet disparaîtra. Pour enlever toutes les sélections, allez 
dans «User Flags > Clear all User Flags». Tout ce qui avait été sélectionné est 
maintenant enlevé! 
 
 
FILTRAGE DES CACHES 
 
Un des outils le plus puissant de GSAK est le filtrage. Le filtrage vous permet de 
sélectionner un sous-ensemble de caches et d'afficher celles-ci sur la grille. Vous pouvez 
ensuite enlever, déplacer, copier, exporter ou envoyer ce sous-ensemble de caches à 
votre GPS d’un seul coup. 
 
Pour avoir un aperçu du fonctionnement du filtrage, cliquez sur la colonne «User Flag» 
pour sélectionner quelques caches. Maintenant, appuyez sur la touche F8 de votre 
clavier. Vous vous apercevrez que les seules caches sur la grille maintenant, sont les 
caches que vous aurez choisies avec les «User Flags». Vous venez de filtrer les caches 
pour celles que vous aviez sélectionnés avec les crochets et vous pouvez travailler avec 
ces caches comme un sous-ensemble. Allez à «User Flags > Clear all User Flags», ou 
appuyez sur la clé F73 de votre clavier pour enlever tous les «User Flags» et à nouveau, 
vous aurez toutes vos caches. 
 
Le filtrage GSAK est beaucoup plus utile que juste se servir des «User Flags» ou 
crochets. Pour filtrer vos caches d’autres manières, allez à «Search > Filter». Vous 

                                                 
3 Votre curseur devra obligatoirement se trouver dans la partie supérieure de votre écran si votre affichage est divisée (Split 
screen), sinon la commande n’aura pas le même effet. 



pouvez aussi cliquer sur le bouton «Filter» sur la barre d’outils GSAK, qui ressemble à 

ceci : .   
 
Une fenêtre de dialogue ‘Set Filter’ apparaît et vous proposera différents critères de 
filtrage. Il y a plusieurs onglets dans la boite de dialogue, chaque onglet vous donnant 
des critères additionnels à inclure dans vos filtres pour sélectionner certaines caches. 
 
Créons un filtre simple pour vous montrer comment ça fonctionne. Disons que vous 
voulez voir toutes les caches traditionnelles en dedans de 20 km (ou miles) de votre 
maison. Cliquez sur «Search > Filter». Sur l’onglet «General», le quatrième critère de 
sélection en descendant est «Distance». Dans le sélecteur «Any Distance», sélectionnez 
«Less than or Equal to» et tapez 20 dans la boîte de droite du menu (‘kilometres 
radius’). 
 
Maintenant, cliquez sur l’onglet «Other» dans la boite de dialogue et cliquez sur «Clear 
all» à la droite de ‘Cache Types’. Ensuite, sélectionnez le type de cache «Traditional». 
Cliquez sur «GO» en bas à gauche de la fenêtre de dialogue «Set Filter». GSAK 
retourne à la grille et maintenant, les seules caches qui apparaissent sont des caches 
traditionnelles à l'intérieur de 20 Km (ou miles) de votre maison. 
 

Pour annuler le filtre (pour voir toutes les caches à nouveau), allez sur «Search 
> Cancel Filter» ou cliquez sur le bouton avec le gros X rouge sur la barre 
d’outils. 

 
 
ENVOYER  DES  WAYPOINTS À  VOTRE  GPS 
 
GSAK peut exporter un sous-ensemble de waypoints directement à vos unités GPS 
Garmin ou Magellan. Un sous-ensemble est ce qui apparaît sur votre grille au moment 
de l’envoi. Alors, si vous avez mis un critère pour filtrer vos caches, ce seront celles-ci 
qui seront envoyées à votre GPS. 
 
En premier lieu, allez à «GPS  > Setup». Choisissez une marque de GPS (Garmin ou 
Magellan). Si votre GPS se branche à votre ordinateur en utilisant le port USB (non un 
câble convertisseur USB à série), cochez la boîte «GPSr is USB». Si votre GPS se 
branche à votre ordinateur, utilisant un câble série ou un câble convertisseur USB à 
série, laissez la boîte vide (sans crochet) et sélectionnez le port COM (port série de 
l’ordinateur) auquel votre GPS est branché et, pour Magellan, la vitesse réglée dans 
votre GPS (tous les GPS Garmin utilisent la même vitesse, alors, ce menu est en gris 



pour les Garmin). Finalement, réglez le nombre maximum de waypoints que votre GPS 
peut accepter (voir le manuel du GPS pour déterminer le nombre) et cliquez «OK». 
 
Maintenant, réglez un filtre pour sélectionner les caches que vous voulez envoyer à votre 
GPS (sinon, vous pouvez laisser faire et exporter tous les waypoints d’une base de 
données). Assurez-vous que le total des caches sélectionnées (notées sur la barre de 
statut au bas de la grille) n’est pas supérieur au nombre que votre GPS peut accepter. 
 
Branchez votre GPS à votre ordinateur et allumez-le (votre GPS devra au préalable avoir 
été configuré par votre système d’exploitation). Maintenant, allez à «GPS > Send 
Waypoints» et cliquez sur «Send». Les waypoints sélectionnés seront transférés à votre 
GPS. 
 
Vous n’avez pas un Garmin ou un Magellan? Ou vous voulez envoyer les waypoints à 
un autre programme utilitaire (par exemple, un programme de cartes sur votre 
ordinateur)? Voir ci-dessous, pour Exporter. 
 
 
EXPORTER DES CACHES 
 
Réglez un filtre pour sélectionner les waypoints que vous voulez exporter (ou vous 
pouvez passer outre le filtre et exporter tous les waypoints de votre base de données). 
 
Allez à «File > Export» et sélectionnez le type d’exportation (pour correspondre soit à 
votre GPS ou au programme utilitaire où vous voulez exporter). Une boîte de dialogue 
va apparaître, qui est spécifique au type correspondant. Il y a trop de différents types 
d’exports à couvrir ici. SVP, référez-vous au «Help File» de GSAK pour de plus amples 
renseignements («Help > Contents» ou la clé F1 sur votre ordinateur). 
 
Pour renseignements sur la manière d’utiliser le «Help File» GSAK, SVP vous référer 
aux notes sur le forum GSAK. Il y a une petite section en français où vous pouvez 
obtenir des informations. 
 
Amusez-vous bien avec GSAK ! 
 
Pour la suite de cette série, SVP voir GSAK 201 – Personnaliser GSAK que vous 
pouvez télécharger en anglais ici : 
http://gsak.info/board/index.php?showtopic=2335&view=findpost&p=13777 . 
 
 

http://www.gsak.net/board/index.php?showtopic=955&st-entry5743
http://gsak.info/board/index.php?showtopic=2335&view=findpost&p=13777


Nota bene :  Tout au long de cette traduction, j’ai gardé les termes du menu GSAK en 
anglais, car GSAK n'existe pas en version française. Dans le cas où une fenêtre 
Windows apparaît, les termes français sont donnés. J’espère que ça va vous aider, tous et 
chacun. 
 
 

 

 

 

L’Association Géocaching Québec par l’intermédiaire de ses membres, est heureuse 
de vous offrir cette traduction du document original GASK101_English.doc. 
 
Traduction :   Jean Power (BigJohnP) 
Révision et adaptation: Pierre Gaudreault (Équipe Ti~Pou) 
 
Et visitez le tout premier forum de discussion de langue française a parler et discuter 
de géocaching et GPS. 
 

Version du 19 janvier 2008

http://www.geocaching-qc.com/phpBB2/
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